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Chapter 1.

Introduction

All developers and process analysts who are beginning to use JBoss jBPM should read this
Getting Started guide. It will give them a jumpstart showing how to create a process definition.

1.1. Preface

This document introduces the use of the JBoss jBPM Graphical Process Designer (GPD) to create
workflow processes. It will help first time users with the following tasks :

Install the JBoss jBPM GPD Eclipse plugin available from the JBoss jBPM download area
» Set up a Java project in Eclipse and prepare it to do test driven process development
 Using the creation wizard to create an empty process definition

» Use the designer palette to draw the first processdefinition

» Show how the xml processdefinition can be inspected as an xml file

» Set up a Java project in Eclipse and prepare it to do test driven process development

» Write an example process test case

If you have questions, please feel free to contact Koen Aers [mailto:koen.aers@jboss.com] or
Tom Baeyens [mailto:tom.baeyens@jboss.com] for more information.

1.2. Feature list

JBoss jBPM is a workflow that enables creating and automatization business processes. Look at
the list of features below to understand its main functionality.

Table 1.1. Key Functionality for JBoss jBPM

Feature Benefit

jBDL support Enables managing workflow processes as well
as human tasks and interactions between
them. jBDL combines the best both Java and
declarative process techniques.

Support of Graphical Process Designer (GPD) | Is used for simplifying declarative process
development and visualizations of all actions.

Project Creation wizard Allows to create a new jBPM template project
that already includes all advanced artifacts and
core jBPM libraries.
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Feature Benefit

Rich palette of pre-build process nodes

Support of XML code view

Properties view

Provides process-building functionality and
gives opportunity even non-programmers to
develop processes.

Shows the corresponding XML that's
generated automatically in the Source view of
the process definition editor when developing
the process.

Facilitates configuring and editing of all nodes
properties.

Interaction with all of the J2EE based
integration  technologies including Web
Services, Java Messaging, J2EE Connectors,
JBDC, EJBs.

Enables implementation, provides better

functionality and flexibility.

Integration with jBoss Seam

Allows to write applications with complex
workflows and provides easier interactions
between them.

1.3. Other relevant resources on the topic

All JBoss Developer Studio/JBoss Tools documentation you can find here [http://www.jboss.com/

products/devstudio/docs].

The latest documentation builds are available here [http://download.jboss.org/jbosstools/nightly-

docs/].
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JBoss |BPM Runtime Installation

The main purpose of this chapter is to let you know how to launch the JBoss jBPM (business
process management).

The jBPM plugin (jJBPM Designer) is already included in the JBoss Tools. To make it
work, you should only download the jBPM runtime (jbpm-jpdI-3.2.2 [http://sourceforge.net/
project/showfiles.php?group_id=70542&package_id=145174&release_id=539054s]  currently)
and specify the directory where you extracted the runtime either when you create a jBPM project
or by using the jBPM preference pages.

Navigate to Window > Preferences > JBoss jBPM > Runtime Locations. Here you can add, edit
and remove JBoss jBPM installation locations. Click Add button. In the dialog that appeared
enter a name for a newly added jBPM runtime and point to the correct location of this package
on your harddrive. Click OK then click OK again.
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Figure 2.1. Adding jBPM Location

Now, when you have a runtime installed, we are going to demonstrate some powerful features
of the jBPM.
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A Guided Tour of JBoss |JBPM GPD

In this chapter we suggest a step-by-step walk-through of creating and configuring your own simple
process. Let's try to organize a new jBPM project.

A wizard for creating a jBPM project is included in the GPD plugin. We have opted to create a
project based on a template already containing a number of advanced artifacts that we will ignore
for this section. In the future we will elaborate this wizard and offer the possibility to create an
empty jBPM project as well as projects based on templates taken from the jBPM tutorial.

3.1. Creating a jBPM Project

This section will show you how to use the Creation wizard for creating a new jBPM project with
already included source folders.

At first you should select File >New Project... and then JBoss jBPM > Process Project in the
New Project dialog:

Select a wizard p—

A wizard that creates a new jBPM Project

Wizards:
[t-_.rpe filter text

[»]

=
7

=
=

I
P
I = Java Emitter Templates
I (= JavaServer Faces

A4

(= |Boss [BFM

5% process Definition

» Process Project

I (= |Boss Tools ||

@ . Next= l Cancel
SR

Figure 3.1. New Project Dialog

Clicking Next brings us to the wizard page where it's necessary to specify the name and location
for the project. We choose, for example, HellojBPM as the name and accept the default location.
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r New Process Project x

Process Project

Create a new process project.
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] Use default location
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Figure 3.2. Process Name and Location

Thus, our project will be created in the workspace root directory by default. If you want to change
the directory for your future project, deselect Use default location and click Browse... button to
set needed location or simply type it.

On the next screen you'll be prompted to select the core jBPM location that we have defined in
the previous chapter.




Creating a jBPM Project

£ New Process Project x

Choose Process Project Detalis

Choose Process Project Details

Choose the Core jJBPM Location for this project

| jBPM_runtime 3

Check to enable generation of sample files in the project
[¥] Generate simple process definition, action handler and |Unit test

[ Finish H Cancel

Figure 3.3. Core jBPM Location Specifying

Clicking on Finish results in the project being generated. The wizard creates four source
folders: one for the processes ( src/main/jpdl ), one for the java sources ( src/main/java ), one
for the unit tests ( src/test/java ) and one for the resources such as the jopm.properties and the
hibernate.properties files ( src/main/config ). In addition a classpath container with all the core
jBPM libraries is added to the project
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Figure 3.4. Layout of the Process Project

Looking inside the different source folders will reveal a number of other artifacts that were
generated, but we will leave these untouched for the moment. Instead, we will look at another
wizard that enables us to create an empty process definition.

3.2. Creating an Empty Process Definition

Now when the projectis set up, we can use a Creation wizard to create an empty process definition.
Bring up the New wizard by clicking the File > New > Other... menu item. The wizard opens
on the Select Wizard page.
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Figure 3.5. The Select Wizard Page

Selecting the JBoss [BPM category, then the Process Definition item and clicking on the Next
button brings us to the Create Process Definition page.
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F New Process Definition x

Create Process Definition

Create a new process definition

Choose a source folder and a process definition name.

Source folder - [Hellulﬁmfsrmnalnﬂpul ] Browse. .. |

Process name : lhElIﬂ I

T |

Figure 3.6. The Create New Process Definion Page

We choose hello as the name of the process archive file. Click on the Finish button to end the
wizard and open the process definition editor.
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A Minimal Process Definition

(G JBPM JPDL - Helle|EPM/sre/main/jpdi/hello/processdefinition.xml - Eclipse Platform =l
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Figure 3.7. The Process Definition Editor

You can see in the Package Explorer that creating a process definition involves creating a folder
with the name of the process definition and populating this folder with two .xml files : gpd.xml
and processdefinition.xml.

The gpd.xml contains the graphical information used by the process definition editor. The
processdefinition.xml file contains the actual process definition info without the graphical
rendering info. At present, the GPD assumes that these two files are siblings. More sophisticated
configuration will be supported later.

3.2.1. A Minimal Process Definition

Now we are ready to create a very simple process definition consisting of a begin state, an
intermediate state and an end state.

To make the configuration of actions much easier it's better to use the jPDL perspective. It provides
the tabbed Properties Editor which allows to configure all the relevant properties of the current
selected item.

3.2.1.1. Adding the Nodes

At first select respectively Start, State and End on the tools palette and click on the canvas to
add these nodes to the process definition. The result should look similar to this:
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Figure 3.8. A Simple Process With Three Nodes

3.2.1.2. Adding Transitions

Then, we will connect the nodes with transitions. To do that select the Transition tool in the tools
palette and click on the Start node, then move to the State node and click again to see the
transition being drawn. Perform the same steps to create a transition from the State node to the
End node. The result will look like:
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( v |
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Figure 3.9. A Simple Process With Transitions

Now, when you've got background knowledge of simple project creation, let's move to more

advanced tools.
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Chapter 4.

The views

Here, it will be explained how to work with views and editors provided by JBDS.

The views are used for representation and navigation the resources you are working on at the
moment. One of the advantages of all the views is that all modifications made in the currant-active
file are immediately displayed in them. Let's get acquainted more closely with those that the jPDL

perspective provides.

f JBFM |PDL - HelloJBPM/bin/hello/processdefinition.xml - Eclipse Platform
File Edit View MNavigate Search Project Bun Window Help

3= @ (-0 Q- | EHEG | &SSP PR

ifjePMJPDL *

| e
™ swimlanes E' L% Process Definition

¥ soNodes The Qutline View meral Mame heflo
= (3 start-statel | Exceptions Description
G Events Tasks
— = Transitions Actions
—+ transition L Swimlanes
[T+ =

)
r

=R
'% Package Explorer &3 =8 i The iPDL cfi — =l
1 ej perspective
=B 7| L select
i_i Marquee
ST
. : Start 0 <<Start States>
P (2 sre/mainfjava e State startstated
I (% sre/mainiconfig ® End
(2 sre/mainjpdl *(3 Fork
P (% sreftestjava &= Join o <Statesx
b ) ) 2 Decision =
B JRE System Library [jekl state1
] ) ) ) £ Node
I =4 jBPM Library [jBPM_runtir ¥\ Task Node
b = sre @ Mail Node
& Process . wcEnd Statens
Il [ I»] State end-state1
~ 55 Super State
7 overview 2 = g|[*==4F
1| —+ Transition
o=
The jBPM GPD Editor
s The Overview
lDiagram Deployment Design | Source
o ; = [ Properties 2 ) ) =8
5 outiine 1 = The Properties View -

Figure 4.1. The jPDL Perspective Views and Editors

As you can see in the picture above, the JPDL perspective contains a complete set of functionality

that's necessary for working on the jBPM project.
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Chapter 4. The views

4.1. The Outline View

To have a way to quickly see an outline of the process use the Outline view that is presented as
the classical tree. If it is not visible select Window > Show view > Oultline.

oF Outline 2 ¥ =0
™ swimlanes
¥ @@ Nodes
= 3 stant-statel
Y& Events
w = Transitions
—¢ transition
= o= ghatel
Y& Events
= =& Transitions
—+ transition
[ B end-statel
@ Events
%5 Action Elaments

k] Tasks

Figure 4.2. The Overview View

4.2. The Overview

The main advantage of this view is that it gives visual representation of the whole currant-
developing process. Besides, the Overview comes as a scrollable thumbnail which enables a
better navigation of the process structure if it's too large.

f overvie . 8 Outine = O

[ E—

Figure 4.3. The Overview

4.3. The Properties View

Here, we dwell on the JBDS Properties view.
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The Properties View

Notice if it's not visible you can access it by navigating Window > Show view > Properties.

The view shows the relevant properties of the selected item in the tabbed form. Every item has
its own set of properties, which can be directly editable in the Properties view or by brining up

the context menu.

P *hallo E5

[+ select
i Marguee
3 Start

~# State

& End

3 Fork

2= Join

7 Decision

G oSt Slatesx
etart-gtate

Lto_auction

.
e o Siale s
atate

¥ Node

"f’ Task
Node

# Mail Node

4 Process [
State end-state1

<cEnd Statess

= Super
State

—+ Transition

Diagram  Deployment Design | Source

] Properties

¢ Transition

General Name to_auction
Condition Description

Exceptions

Actions

Figure 4.4. The Properties View of selected Transition

For example, on the picture above the Properties view displays all the properties for a selected
transition. Its name has been changed to to_auction. We've done it directly in active General tab
of the view. The same way let's change the name for the second transition to to_end.

If no one item is selected, the view represents the properties of the whole process definition.
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Chapter 4. The views

[l Properties & T =0

% Process Definition

General Name hello
Exceptions Description

Tasks

Actions

b

Figure 4.5. The Properties View of Process Definition

In this case, it contains six tabs. The first one is the General. It allows to specify a process name
and add necessary description. To illustrate let's change the process definition name to jbay.

4.4. The jBPM Graphical Process Designer editor.

The BPM GPD editor includes four modes: Diagram, Deployment, Design and Source, which are
available as switchable tabs at the bottom of the editor. Let's dwell on each of them.

4.4.1. The Diagram mode

In this mode we define the process in the form of a diagram by means of tools provided on the
left-hand side of the jBPM GPD.

[F] *hello 22 =0

[3 select
i Marquee
i} Start D c<Rlan Slales»
o State jbay

i End
3 Fork to_auction

= Join

2 Decision e

2} Node auction | ]

¥ Task Node -

Z# Mall Node

<& Process
State -

= Super State end-state]

—+ Transition

ceEnd Shatasx

Diagram Deployment Design Source

Figure 4.6. The Diagram mode

Besides, some properties can be directly edited in the Diagram mode of the graphical editor. One
example of this is the name property of nodes. You can edit this directly by selecting the node of
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The Source Mode

which you want to change the name and then click once inside this node. This enables an editor
in the node. We change the name of the node to auction.

4.4.2. The Source Mode

Now, that we have defined a simple process definition, we can have a look at the XML that is being
generated under the covers. To see this XML click on the Source tab of the graphical process
designer editor.

|F| halla 22 =0

=7xmL version="1.0" encoding="UTF-8" 7>

<process-definition xmlas="urn:jbpm.org:jpdl-3.2" name="hello™>

<start-state name="start®:>
=transition to="auction® name="to_auction"=</transition=
<fstart-statex>

<state name="auction” =
=transition to="end" name="to_end"></transition>
<fstate=

<gnd- state name="end" ></end- states

<fprocess-detinltions

|4

1 [+]
Diagram Deployment Design |Source

Figure 4.7. The Source Mode

The Source mode enables to easily manipulate our XML. That is manually inserting and editing
necessary elements or attributes. In addition, here you can take advantage of content assist.

4.4.3. The Design Mode

One more way to edit your file is to use Design mode. You can see it in the next picture:

17



Chapter 4. The views
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Figure 4.8. The Design Mode

As you can see above, this mode looks like a table in the first column of which the process structure
is performed. Here, you can also insert, remove and edit elements or attributes, moreover add
comments and instructions. Their values can be directly edited in the second column of the Design

mode table.

For instance, let's add a comment on the second transition. For that, you should bring up the

context menu for it and choose Add Before > Comment.
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The Design Mode

_. i -

=7 xmil version="1.0" encoding="UTF-8"
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Figure 4.9. Adding a Comment

Then, we can put the text This transition leads to the end state in the right column as its value.
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e B "o
—
=7 xmil version="1.0" encoding="UTF-8" =
- E pmcesg-ﬂeﬁniﬁﬁn {description | swimlane | start-state | {((node | state task-node
@ xmins umn: jbpm.org:jpdl-3.2
@ name jbay
- E shart-state {descrnpiion | task transition | event exception-nandler)*
@ name start
- E transition {descnpiion | conaition | ({action | sCrpt | create-oimer | cance
@ to auction
@ name to_auction =
= [e] state {{{description | event | exception-handler | timer | transition)))”
@ name auction
_ his transition leads to tha end state
- E transition fdescnption | conaition | {{action | sCcrpt | create-oimer | cance
@ to and
@ name to_end
= [g] end-state {description | event | exception-handler)*
@ name end E
Diagram |Deployment Design 5aun:e|

Figure 4.10. Comment is added

4.4.4. The Deployment Mode

Finally, to adjust the deployment settings of the project you should switch on to the tab that opens
the Deployment mode. On the picture below the Deployment mode is performed with default
settings. Here, you can easily modify them or, if the settings won't match your needs, to reset
defaults.
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The Deployment Mode
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Diagram ' Deployment - Deslgn. Source

Figure 4.11. The Deployment Mode

The button Test Connections is necessary to make sure whether all your settings are valid before
deploying the process.

Now that we've seen how to work with jPDL perspective, let's pass on to the project testing.
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Chapter 5.

Test Driven Process Development

One of the most important advantages of JBoss jBPM's lightweight approach to BPM and workflow
management is that developers can easily leverage their usual programming skills and techniques.
One of these well-known techniques is Unit Testing and Test Driven Development.

In this chapter we will show how developers, making use of the JBoss jBPM GPD, can use a
technigue we have baptized Test Driven Process Development to create process definitions and
test their correctness.

When creating the HellojBPM project the Project Creation wizard has already put in place all the
library requirements we need to start writing the jBPM unit tests. They are contained in the jBPM
Library container and the most important of them is the .jar file containing the core jBPM classes.
While working on the project you could find them all in the Package Explorer.

[l Package Explorer % =0

I = A

P ma JRE System Library [jdkl1.5.0_12]
= B JBPM Library [jBPM_runtime]
[ = hibemnate3 jar - frootDesktopibprm-jpdl-3.2 21
= hsgldb jar - frootDesktopfopm-jpdl-3.2 210ib
= antlr-2_7 6 jar - froot/Desktopjbpmi-jpdl-3.2_ 24

commaons-collections jar - frootDesktop/jbpm: —

domdj jar - froctDesktopfbpm-jpdl-3.2 21ib

=/ asm jar - frootDesktop/jbpm-jpdl-3.2_2/ib
&0 |bpm-identity jar - froot/Desktop/bpm-jpdl-3.2 .
= mail jar - frootDesktop/jbpm-jpdl-3.2 .2/t
=/ activation jar - frootDesktop/jbprm-jpdl-3 .2 2/it

P

[

P

[

P

[

P

[

P bshjar - frootyDesktop/opm-jpd-3.2.20ib
P = logd)jar - rootDesktopjbpm-jpdl-3.2 20ib

P m jposs-j2ee jar - frootDeskiopibpme-jpdl-3.2. 210
[ = serviet-apl jar - frootDesktop/oprm-jpdl-3.2 2/
P L5 jppm-jpdljar - frootDesktopibpm-jpdl-3.2.2

[ = jor-1.0jar - frootDesktopjbpm-jpdi-3.2.21ib

P m commons-logging.jar - frootDesktopjopm-jpd
[

= cglib jar - frootDesktopibpm-jpdl-3.2. 20ib

A junitjar - frootDesktopjbpm-jpdl-3.2.2/ib

= src =

Figure 5.1. The jBPM Libraries

It must be noted that it is possible to change the location of the core jBPM installation by changing
the preference settings. More on this see later in this book.
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With that extra knowledge on the project settings, you can create your first test. To do this, we
create the com.jbay package in the test/java source folder. Then we bring up the context menu
on this package and select New > Other...

= 1= HellgjBPM
B srejmainfjava
b (B sre/main/config
BB srefmaingjpd

= [ sreftestjava

b com.sample

R Y - Project

b mi JRE System Lirz  OPen in New Window i Package
b i [BPM Library [j8P Open Type Hierarchy F4 | (& Class
B Show In Shift+AIL+W  * | F Interface
B = sre i
e e & Enum
i= 4
- Cﬂp'_r =t (@ Annotation
A= Co ualified Narme B
? Py Q & Source Folder
" Paste Ctri+v |
) 7 Folder
¥ Delete Delete |
LT File
|7 Untitled Text File
al Build Path Pl
™ Example. ..
Source Shift4+AlL+S  *
Refactor Shift+AIL+T »
g2 [mport...
2% Expaort...
< Refresh F5

Assign Working Sets...

Bun As r
Debug As ¥
Profile As 3
Validate

Team k
Compare With ¥

Restore from Local Hislorr_..

Properties Alt+Enter

Figure 5.2. Call the JUnit Test Case Creation wizard

And then Java > JUnit > JUnit Test Case to call the specialized JUnite Test case creation wizard.
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Select a wizard —
Create a JUnit Test Case r_

Wizards:
= = Java
@ Annotation
& Class
& Enum
& Interface
14 Java Project
% Java Project from Existing Ant Buildfile

[»]

# Package
& Source Folder
I+ = DbUnit

= Java Run/Debug
= = JUnit
B |Unit Test Case

FE Unit Test Suite

|EY Serviet Test Case

I = Java Emitter Templates

(4]

@ : [ mext> | " || cancel |

Figure 5.3. Call the JUnit Test Case Creation wizard

The wizard looks as follows:
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£ New |Unit Test Case X

JUnit Test Case
Ay Type name is discouraged. By convention. Java type names usually EZ
start with an uppercase letter

@ Mew JUnit 3 test () New JUnit 4 test

Source folder: [Hellajamfsrcnest.ﬂaua ” Browse. ..
Package: [:nm.iha-,r | Browse. .

Name: [henoTest ]

Superclass: [junit.framewurk.Te:‘;tCa*se ][ Browseg... I

Which method stubs would you like to

] setlp() [] tearDown()
] constructor
Do you want to add comments as configured in the properties of the current projecty

[l Generate comments

Class under test: ] [ Browse...

(il | Finish | l Cancel

Figure 5.4. Create Test Dialog

By default JUnite 3 version of testing framework is selected. Of course, you can choose new
advanced JUnit 4 version. In this case you'll be prompted to add new JUnit Library to your build
path. To add it automatically just click on the appropriate link. In the Class under test section
you can specify the class to test.
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¢ New |Unit Test Case
JUnit Test Case

Select the name of the new |Unit test case. You have the options to
specify

) Mew JUnit 3 test (3 New JUnit 4 test

Source folder: [HellojBPwsrcnesmaua ] Browse. ..

i =

Package: lcnr‘n Jjbay I Browse...

Mame: [HeuaTest |

Which method stubs would you like to
[] setUpBeforeClass() ] tearDownAfterClass()

[ setlp() ] tearDown()

Do you want to add comments as configured in the properties of the current project?

[l Generate comments

Class under test: [ ] Browse...
/4 JUnit 4 is not on the build path of project 'I-IeIujBF‘I'-'I' add |Unit 4 to

the build path and open the build path dialog.

® i) (o) oo

Figure 5.5. A First Test Scenario

Then, we call the test class HelloTest and press Finish button to complete.

Next, we should write a simple test scenario as shown on the next figure. Let's study the code

of this test case.
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JBPM JPDL - HellojBPM/src/test/javalcom/|bay/HelloTest. jJava - Eclipse Platform
File Edit Source Refactor Mavigate Search Project Run Window Help

e L@ pr0ra [ Bee ey e|[4e]Ba e n o [22jepm jeoL] ”

| $l- Bl = &

- [F] hello [J] HelloTest java &2 =8

B | #isport junit.framework.TestCase;l] ]
public class HelloTest extends TestCase {
=R public woid testProcess() throws Exception {

ProcessDefinition definition = ProcessDefinition.parseXmlResource("hello/processdefinition. xml™);
assertNotNull ("Definition should not be pull®, definition);

FProcessInstance instance = nmew ProcessInstance(definition);
assertEquals(
"Definition is in start state”,
instance. getRootToken (). getNode(). getName(),
"start®);

instance. signal();

assertEquals|(
“Definition is in auction state”,
instance.getRootToken (). getNode (). getName(),
"auction”®);

instance, signal();

assertEquals(
"Definition is in end state®,
instance.getRootToken().getNode(). getName(),
“end®);

assertTrue("Instance has ended”, instance.hasEnded(}));

=g Writable Smartinsert  38:1 5 O 5 B

Figure 5.6. A First Test Scenario

In the first line of the method, a jBPM process archive object is created. We use a constructor
accepting the filename of the archive. In our case it is the hello file we created earlier and which
lives in the src/main/jpd| folder of our project. After asserting that this object is really created, we
extract a process definition object from it. This object is fed to the constructor of a process instance
object. We have a process instance object, but this process is not yet started, so we can safely
assert that its root token still resides in the start node. After signalling the token will move to the
next state and the process will be in the auction state. Finally another signal will end the process.

After writing this test we can check whether it works as expected by running it .

28



= =2 Hello|BPM

P = sresm

P (= srefm

= B srcfte

- i col

¥

b g col

[ = JRE Sy

b omhjEPML
b sre

4 [l
7 overview ¥
No view availa’

I (@ srefmainfjava

JBPM JPDL - HellojBPM/src/test/java/com/|bay/HelloTest. Java - Eclipse Platform

[g~0rQ- |2 we- @y |98 2 v 8
- -t;:'c:" -

New

Open

Open With

Open Type Hierarchy
Show In

[ Copy

= Copy Qualified Name
[T Paste

M Delete

Build Path
Source
Refactor

£ Import...
&y Export...

References
Declarations

< Refresh
Assign Working Sets. .

2 on serer st

Debug As
Profile As
Validate
oy Deploy To Server
Team
Compare With
Replace With
Restore from Local History...
Web Services

package com. )bay;
#import junit.framework. TestCase;|]

. public class HelloTest extends TestCase {

File Edit Source Refacter Navigate Search Project Bun Window Help

»
tProcess() throws Exception {
F3
inition definition = ProcessDefinition.parseXmilResource("hello/processdef
Mi{"Definition should not be null”, definition);
F4
Shift+Alt+W + [@nce instance = new ProcessInstance(definition);
s
ctri4+c (finition is in start state®, =
itance.getRootToken () .getNode().getName(),
arty;
Ctrl+W
Delete 0aL{);
s(

, fTinition is in auction state",

itance.getRootToken (). getNode (). getName(),
Shift+Alt+5  * ction®);

SHift+AIL+T  * L=

F5
712:08:14 PM

[4]

| = &

] 2 JUnit Test Shift+Alt+X

*
3 Open Run Dialeg...

Figure 5.7. Running the Process Test

All went well as we have a green light:
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JBPM JPDL - Hello|BPM/src/test/java/com/|bay/HelloTest. java - Eclipse Platform
File Edit Source Refacter Navigate Search Project Bun Window Help

L@ |sse | eveld o]z r = (22w oL |

| 81~ i~ % o~

I Package Explorer 2 =0
S package com. jbay;
= 1= HellojaPM #import junit.framework. TestCase;|]
P (= srefmainjjava -
& sre/mainy public class HelloTest extends TestCase {

P (2 srefmainjconfig

P (2 srefmainfjpd|
= [# srcftestfjava ProcessDefinition definition = ProcessDefinition.parsexmlResource(“hello/processdef
assertNotNull("Definition should not be null™, definitien);

public void testProcess() throws Exception {

= # com jbay

+ [ HelloTest java ProcessInstance instance = new ProcessInstance(definition);

b com.sample assertbquals(

“Definition is in start state",
b m JRE System Library [jdk1.5. instance.getRootToken () .getNode().getName(),
b @i |BPM Library [jopm-jpel-3.2. Tstart’);
b sre instance. signal();
assertEquals|

"Definition is in auction state",
instance. getRootToken (). getNode (). getName(),
a [ D] Tauction”);

“® Overview b2 = G | |r]u

Mo view available

[ properties |fu Junit 52 . Bl Console g &l
Finished after 2 316 seconds .

Runs: 171 o Errors: 0 B Failures: 0 e

v+ % com jbay HelloTest [Runner: jUnit 3] = Fallure Trace

ik Writable Smart Insert  38:1 &5 B

Figure 5.8. Successful Test Run

Of course, this simple scenario was not very interesting, but the purpose of it was to show how you
can reuse your development skills in a very straightforward way when doing process development.
To see how more interesting processes and process test scenario's can be developed, we suggest
you to read the JBoss |BPM User Guide [http://docs.jboss.com/jbpm/v3/userguide/] and to study
the API reference. You can find it in the jBPM download folder. (To get started we downloaded
jbpm-jpdI-3.2.2 in the second chapter. You should just remember where you extracted it.) All we've
mentioned are in the 'javadoc- *' subfolders of the 'doc' folder. Moreover, some more examples

will be given later in this book.
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Chapter 6.

Actions : The JBoss |BPM
Integration Mechanism

In this chapter we will show how to do software integration with JBoss jBPM. The standard
mechanism to implement this is to wrap the functionality you want to integrate in a class that
implements the ActionHandler interface. In order to demonstrate it let's specify Hello World action
for our process.

6.1. Creating a Hello World Action

Each Hello World process should integrate one or more Hello World actions, so this is what we
will be doing. We can integrate custom code at different points in the process definition. To do this
we have to specify an action handler, represented by an implementation of the ActionHandler
interface, and attach this piece of code to a particular event. These events are amongst others,
going over a transition, leaving or entering nodes, after and before signalling.

To make things a little bit more concrete, let's create a new class called HelloActionHandler. For
that firstly we'll create a new package com.jbay.action inthe src/java/main folder of our project.
Then, we should call New Class Creation wizard as usual by right-clicking and navigating New
> Class.
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¢ New Java Class x

java Class
Create a new Java class. Q

Source folder: [HellujBPM.ﬁsrc!main.fiava ][ Browse... I

Package: [cum.ibay.acﬁnn | Browse.. .

[] Enclosing type:

Mame: [Helloﬁ.cl:lunHandler
Madifiers: 3 public () default

[] abstract [] final

Superclass: [jaua.lang.obj-ect ][ Browseg... I

Interfaces: 1. org jbpr graph def ActionHandler | Add ...

| l Remove

Which method 51.'|.|b5. would you like to
[] public static void main(String[] args)
[] Constructors from superclass
Inherited absiract methods
Do you want to add comments as configured in the properties of the current project?
Generate Comments

[id] [ Finlsh || Cancel

Figure 6.1. Creating HelloActionHendler Class

Notice that two first gaps have been filled automatically. Here, instead of Package option Enclose
type option can be selected where a type in which to enclose a new class should be specified.

In our case, we leave everything as it is, just type HelloActionHandler as a name of new class
and add org.jbpm.graph.ActionHendler interface as it's shown in the picture above.

Thus, our HelloActionHandler implements the ActionHandler interface including the execute
method as shown in the next figure. Here, we add a variable named greeting to the collection of

process variables and put a message in it : "Hello from ActionHandler".
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JEPM JPDL - HelloJBPM/src/main/java/com/|bay/action/HelloActionHandler. java - Eclipse Platform
File Edit Source Refacter Navigate Search Project Bun Window Help
s SRS RO R RT S A R N - M
ORI - Y G Gl t v

[F} hello 1] HelloTest java /] HelloActionHandier java i3 =08

&
i package com.jbay.action; L=
#import org. jbpm.graph.def. ActionHandler;|]

public class HelleActionHandler implements ActicnHandler {

private static final leng seriallVersionUID = 1L;

& = public void execute(ExecutionContext context) throws Exception {
context.getContextInstance().createVariable("gritting” , "Hello from ActionHandler®);
} L
}
G |
0 Writable Smar...sert s O gt B & 2=

Figure 6.2. A Simple Hello Action

Now, as we have HelloActionHandler class defined, let's explore how we can handle it.

6.2. Integrating the Hello World Action

The main purpose of this chapter is to provide you with the steps associating our Hello World
action with a particular event and test the correctness of our actions as well.

As good Testcity citizens we will first create a Unit Test that proves the behaviour we want to
achieve by adding the ActionHandler to the process. So we implement another test.

At first, let's return to the code we already saw in the previous chapter and add new test method
testActionHendler to it.
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JBPM JPDL - HelloJBPM/src/test/java/com/Jbay/HelloTest.java - Eclipse Platform
File Edit Source Refacter Navigate Search Project Bun Window Help

=5 [s~0-Q@- | we- @y |90 |3 » 8 o T | 2%eeMpDL 7
b~ Gl % G- -

( I Package Explorer ﬁ i = B8/ [P hello | HelloTest java S&\@ HelloActionHandlerjava =0

2% ~ “start®); ol
= =2 Hello|BPM [=] instance. signal();
} assertfquals|
¥ & sre/mainfjava “Definition is in auction state”,
b 8 com jbayaction instance.getRootToken (). getNode().getName(),
"auctien®);

P # com.sample action
P 2 sre/main/config instance. signal();

b 1 assertEquals| ||
sre/mainjpd 3 “Definition is in end state",
= [# groftestjava instance.getRootToken().getNode().getName(),
“end”);

= i com jbay

+ 0 HelloTest java assertTrue(”Instance has ended”, 1nstance.hasEnded());

b com.sample 1
P m JRE System Library [jakl| || public woid testActionHandler() throws Exception{
b = |BPM Library (jopm-jpdi-3 ProcessDefinition definition = PrecessDefinition.parsexmlResource(“hello/processd
a] I ] [+ ProcessInstance instance = new ProcessInstance(definition);

assertNotNull("The greetings variable should not exist™,

= . =g
&7 overview “~ instance.getContextInstance().getVariable("greeting®)});

No view available

instance.signal();

assertEquals(
"The greetings variable is created",
instance.getContextInstance().getVariable("greeting"},
"Helle from ActionHandler");

G m I ol
I ne com jbay HelloTest java - HellojBPM/srctestjava I | e O g B[l =

Figure 6.3. Create the Hello Action Test

We assert that no variable called greeting exist. Then we give the process a signal to move
it to the auction state. We want to associate the execution of the action with the event of going
over the transition from the start state to the auction state. So after the signal, the process should
be in the auction state as in the previous scenario. But moreover, the greeting variable should
exist and contain the string "Hello from ActionHandler". That's what we assert in the last lines of
the test method.

Running the tests now results in a failure. The point is that we did not associate the action with
any particular event in the process definition, so the process variable did not get set.
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£ JBPM JPDL - HellojJBPM/src/test/java/com/jbay/HelloTest. Java - Eclipse Platform Sl |
File Edit Source Refacter Navigate Search Project Bun Window Help
iz PO~ Qr B H G | & @ @ B |- K I |2%EeM DL 7
w G
|# Package Explorer 2 = B8 | [F helio [ HelloTest java [J] HelloActionHandler java =8
B ! “Uefinitlon 1s 1n end state”, (=]
9 = - instance.getRooatToken (). getNode().getName(), ]
= 122 Hello[BPM - “end”);
¥ [# src/mainfjava assertTrue("Instance has ended", instance_hasEnded{));
b i com jbay.action 1

b & com.sample.action E public woid testActionHandler() throws Exception{

P2 srefmain/config ProcessDefinition definition = ProcessDefinition. parseXmlResource("hello/processd
b (= sre/mainfjpd ProcessIinstance instance = new ProcessInstance{definition);
= & srctestjava assertNotNull("The greetings variable should not exist”, [l

< @ com joay instance.getContextInstance().getVariable("greeting”));

+ 0 HelloTest java instance.signal();

b B com.sample assertEquals|
) P “The greetings variable is created",
P m4 JRE System Library [jakl instance.getContextinstance().getVariable( “greeting”),
b @ [BPM Library [jopm-jpdl-3|— Helle from ActionHandler®);
B = ere =) } |
) | -
= k|
< overview =0 I [ v
No view available 1 Properties gt B console 4 BB R E~ = =0
Finished after 4 44 seconds
Runs: 2/2 @ Errors: 0 O Failures: 1 I
= @i com jbay HelloTest [Runner: JUnit 3] = Failure Trace o=
f] testProcess 40 junit framework AssertionFailedError; The greetings val -

B testActionHandler e e et Ta ke R A e fa e o Tt T ok fa s

Figure 6.4. Test Results Before Integration

Let's do something about it and add an action to the first transition of our sample process. To do
this you can use the Actions tab in the Properties Editor that is under the graphical canvas. Bring
up the popup menu of the action element container and chose New Action as it's shown on the
figure below. The other way to add an action to the transition is simply to use the dropdown menu
that is available under the action icon in the right upper corner of the Properties View.

T Properties £ = v en

—+ Transition

General | [

Condition

Exceptions <" New Script

% Actlons 4 Mew Create Timer [
# New Cancel Timer
: b
| » .

G @ New Mail =

Figure 6.5. Adding an Action to a Transition

After adding the action a tabbed view with three pages will appear.
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T Properties i3 &+ % v =0
%% Process Definition

e General Details Advanced
Exceplions Name

Tasks

+ Actions

Swimlanes

= [

Figure 6.6. Configuration Dialog for an Action
The first of these three pages allows you to give the Action a name. The last page contains some

advanced attributes such as whether the Action is asynchronous. The Details page is the most
important. It allows to choose and configure the actual action handler implementation.

O Properties 1

'_;,‘ ” = = B
as

ao Process Definition

po— m General | Details| Advanced

Exceptions Handler |+ ‘ Class Name Search..| Config Type SR [~

Tasks ) A

- The class does not exist on the project classpath.

+ Actions

Swimlanes

hd

Figure 6.7. The Details page of an Action Configuration Dialog

Clicking on the Search... button brings us to a Choose Class dialog.
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F Choose Action Handler *»
Choose an action handler from the list -
[hEIIu ]
Matching itermns:

'€ HelloActionHandler - comn jbay action

. f# com jbay.action - HellojBPM/src/imainfjava

(il | OK I[ Cancel I

Figure 6.8. The Choose Action Handler Dialog

We choose our previously created 'HelloActionHandler' class and push the OK button. After the
selection of the action handler for the action, we can run the test and observe it gives us a green

light.

37



Chapter 6. Actions : The JBos...

JBPM JPDL - HelloJBPM/src/test/java/com/jbay/HelloTest. Java - Eclipse Platform

File Edit Source Refactor Navigate Search Project Run Window Help
jer L@ w0 |swe | ese |4 o|B e n | 81~ §i- © & < B (28] *

|J] HelloActionHandler java =0
% - k=

assertTrue("Instance has ended”, instance.hasEnded());
~ 1=} HellojgPM }

B ® srefmainfava

i Package Explorer 8 . 7 8 || nelle

!

public void testActionHandler() throws Exception{
P (# src/main/config ProcessDefinition definition = ProcessDefinition.parseXmiResource(”hello/processdefinition.xm
b (® srcfmainfpd
ProcessInstance instance = new ProcessInstance(definition);
¥ [ srcftestfjava assertNull("The greeting variable should not exist",

= @ com jbay instance.getContextInstance().getvVariable("greeting”});

+ 0 HelloTest java —

P & comsample instance. signal();
} . assertEquals(
b =4 JRE System Library (jdk1.5. “The greeting variable is created”,
b =4 jBPM Library [jopm-jpdi-3.2. instance.getContextInstance().getVariable(“greeting”},
b "Hello from ActionHandler®);
& src
}
} E
i I+
d - ' I'I. [ Properties | gif Junit & . & Console g® G| @ B> ¥ =0
" overvie |2 Outline 8 = B |/Finished after 2.255 seconds
B RN o W T auns: 2 @ Emrors: 0 @ Failures: 0 e ]
. = Failure Tr
b “: impart declarations * g com jbay HelloTest [Runner: |Unit 3] Failure Trace
£t testProcess

= @ HeloTest

3 testActionHandler
o testProcess()

@ testActionHandler()

[0 | 1 I ]
o* Writable Smart insert  1:1

Figure 6.9. Test Results

Tere we are. The above objective has been achieved.

6.3. Integration Points

The different integration points in a process definition are thoroughly documented in the JBoss
jBPM User Guide [http://docs.jboss.com/jbpm/v3/userguide/]. Instance nodes can contain many
action elements. Each of these will appear in the Action element list of the Actions tab. But each
Action also has a properties view of itself. You can navigate to this view by selecting the added
Action in the outline view.
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Chapter 7.

Quick Howto Guide

This chapter contains additional information related to the JBoss jBPM.

7.1. Change the Default Core jBPM Installation

You can change the default jBPM installation by means of the Eclipse preference mechanism.
Open the Preferences dialog by selecting Window > Preferences and select the JBoss jBPM >
Runtime Location category. Using this page you can add multiple [BPM installation locations and
change the default one. The default installation is used for the classpath settings when creating
a new Process Project. Changing the preferences has no influence on already created projects.
Getting rid of a jBPM installation that's being referenced by a project however will cause the
classpath to contain errors.

¢ Preferences x
|_-t5.rpe filter text ] Runtime Locations Sow
¥ General = Add, remove or edit [Boss JBPM installation locations.,
b Ant The checked lacation will be used by the jBPM creation wizards.
b Connectivity jBPM Installation Locations:
FreeMarker Editor . Marme Viersion Loc ation . Add.
HGL editor
I InstalUpdate
B Internet
I Java g
= |Boss |BPM
Assignment Types
Jpd! Templates

Server D Eployme

b |Boss Tools

| | m Restore Qeraults” Apply
3

@ [ oK I | Cancel

Figure 7.1. The jBPM Preferences Page

7.2. Configuring Task Nodes

Here, we'll examine how you can configure the Task nodes in jBPM jPDL GPD.

You can add Tasks to Task nodes and then configure them in a similar manner as the Action
configuration mechanism. Let's consider the process definition similar to the previous one that
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contains three nodes: Start state, Task node and End state. The Properties view for selected Task
node includes several tabs.

JBPM JPDL - Hello]JBPM/src/main/|pdi/task/processdefinition.xml - Eclipse Platform
File Edit View Navigate Search Project Bun Window Help

v [0 | BEE @y e |08 R - Gl ® G O m [22eem o] ”

[ Package Explorer i =8 | B rtask 2 =0
2 & 7|l select
i Marguee
= 1=} Hello[BPM |
) start
[ [ sro/mainfjava e Stata 0 <<Start Statas>
P (# sre/mainiconfig @ End st
= [® srofmainfpd «3 Fork
b {2 hello & Join . <<Task Nodes>
b & simple .7 Decision =l
¥ Node
= B task % Task Node
¥ Forms.xmi & Mail Node
® gpd.xmi ¢S Procese State ™ <<End Stale=>
end
b processdefinition. xmi 2% Super State
& processimage jpg —PUEIEL
B (® srctestjava
I» ®h JRE System Library [jokl.5.
I ® jBPM Library [JBPM_runtime]

Diagrarm [ Deployment Design Source

b = sre
'l I D [ Properties 52 a =T
2 ®overvie | = O T Task Node
M swimlanes =] | General
= gg MNodes Exceptions
b Q) start ¥ Tasks
= i task-node Events
& Events Timers
b = Transitions —1 | Advanced
5 Tasks ]
[ ® end =] ] : :

-

Figure 7.2. The Properties View of the selected Task Node

We should choose the Task tab and then bring up the context menu or click the button in the top
right corner of the view to add a Task to our Task node.

¥ Task Node

General |
Exceptions
Sneks |
Events i

Timers

Advanced

- : o

Figure 7.3. Adding a Task to the Task Node
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Configuring Task Nodes

Every added Task has its own configuration possibilities. You can access them through the
Properties view as well.

[l Properties i3 ¢ % ¥=0
¥ Task Mode

e General Details| Assignmnent Controller| Reminder
Exceptions Mame

¥ Tasks

Events

Description

Timers

Advanced

4]

Figure 7.4. The Task properties

The General page is a place where you can specify the name of a Task and its description. For
instance, let it be approve oder with appropriate description that you can see in the figure below.

[l Properties £2 R S =
¥ Task Node

General ﬂapprgve oder General Details | Assignmnent| Controller| Reminder

Exceptions Name approve oder
¥ Tasks Description  This task shows the approval form to the approver [=
Events

Timers

Advanced

Figure 7.5. The Task General Page

Now, look at Details page. First, you should specify the due date that is a mandatory property for
the Task. The due date is the date on which the task should be accomplished. Here you can also
set a Task priority as well as signalling, notifying or blocking. The Blocking attribute indicates that
the process will not be able to continue if this task is still unaccomplished. The Generate Form...
button is for creating a simple task form that can be rendered by the jBPM console.

T Properties & ¢ ® ¥ =0
¥ Task Node

General ﬂwpru\ae oder General Details Assignmnent Controller Reminder

Exceptions Due Date |3 business days
] Tasks Priority high - ] Blocking [ Signalling [ Notify
Events — _
| Generate Form...
Timers )
Advanced

[0

Figure 7.6. The Task Details Page
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Chapter 7. Quick Howto Guide

For our example, we specify the due date as 2 business days, choose the high priority and also
check the Signalling and Notify attributes. It means that the Task should be accomplished in
2 business days and the assignee will be notified by email when the task is assigned. To specify
how the Task should be assigned switch on to the Assignment page.

Tl Properties £2 & ® =0
¥ Task Mode

— General | Details | Assignmnent| Controller| Reminder

Exceptions
¥ Tasks
Events

Actor |" | Actor gjl

Timers

Advanced

Figure 7.7. The Task Assignment Page

On the Reminder page you can specify whether the assignee will be reminded of the task that
awaits him.

T Properties £3 B S =
¥ Task Node

General

General Details Assignmnent Controller Reminder

Exceptions | il :Configl.lre Reminder

<] Tasks Due Date 2 business hours
Events Repeat 1 business hour
Timers

Advanced

Figure 7.8. The Task Reminder Page

In our case, the assignee will be reminded by email after two business hours and continue to get
reminding every business hour after that.

In the next figure you can see our configuring generated into XML.
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Configuring Task Nodes

=?xml version="1.8" encoding="UTF-87=

<process-definition xmlns="urn:jbpm.org: jpdl-3.2" name="task">

=start.state name="start">
=transition to="task-node"=</transition=
</start-statex

=task-node name="task-node”>
=task name="approve oder" priority="high" duedate="3 business days" notify="true"=
<gescriptions
This task shows the approval form to the approver
<fdescription=
=assignment actor-id="Bill"></assignment=
scontroller class=""=>=</controller>
<reminder duedate=""/>
</task=
<transition to="end"=</transition>
=/task-node>

<end-state name="end"></end-states>

=/process-definition>

(<]

Diagram Deployment Design |Source

[4]

Figure 7.9. The Task Reminder Page

We hope, our guide will help you to get started with the jPDL process language and jBPM
workflow on the whole. Besides, for additional information you are welcome on our forum [http://

www.jboss.com/index.html?module=bb&op=viewforum&f=217].
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